SAP NetWeaver™ in the Real World

“SAP NetWeaver in the Real World” is a five-part series of technical articles demonstrating a step-by-step implementation of SAP NetWeaver and its key components. The business scenario of the fictional Iridium Motors showcases the components of the SAP NetWeaver stack, and the real-world utility achieved by their integration.
# Table of Contents

SAP NetWeaver™ in the Real World ................................................................. 1
Table of Contents ......................................................................................... 2
Introduction ..................................................................................................... 3
Scenario .......................................................................................................... 5
About the SAP Business Intelligence .............................................................. 6
  Implementation Basics ............................................................................... 6
Prerequisites ................................................................................................... 7
Terminology/Concepts .................................................................................... 8
  Terminology ............................................................................................... 8
  Concepts/Reasoning ................................................................................. 9
Step-by-Step Solution .................................................................................... 12
  Step 1: Creation of InfoObjects for Master Data ....................................... 12
  Step 2: Loading Master Data .................................................................. 20
    Loading InfoObject Text ....................................................................... 20
    Loading InfoObject Attributes ............................................................. 24
  Step 3: Create Additional InfoObjects for Transactional Data ................. 26
  Step 4: Building InfoSource for Transactional Data ................................. 28
  Step 5: Building the InfoCube ................................................................. 32
  Step 6: Create Update Rules for Transactional Data ............................... 37
  Step 7: Load Transactional Data ............................................................... 38
  Step 8: Reporting & Analysis: Create a Query & Web Application .......... 41
Preview of “SAP NetWeaver in the Real World” Part V ......................... 52
References ................................................................................................. 53
Introduction

In Part IV of "SAP NetWeaver in the Real World," centered on SAP® Business Intelligence (BI), the Iridium Motors development team builds a BI InfoCube to streamline equipment reporting processes. The result being: When the production manager, Anne, notifies Raul, the maintenance supervisor, of the equipment failure, he can immediately launch BI reports to analyze past equipment problems and solutions. With information readily available about prior failures, average service time, and corrective actions taken, diagnosing and troubleshooting can commence without delay.
Manufacturing system

Trigger equipment failure

SAP Exchange Infrastructure 3.0

Change status of failed equipment

SAP R/3 based OLTP system

Store historical data in the BI system

WebDynpro application reads equipment status and displays it in Portal

SAP Business Information Warehouse 3.5

Analysis/Reports

SAP Enterprise Portal 6.0

SAP Knowledge Management

Service manuals and documents indexed by SAP TREX search engine

End-user
Scenario

09 September 2004
Iridium Motors, Inc. - Dallas Texas

11:25 a.m.
An alarm sounds on the shop floor of Iridium Motors. A high-speed motor suddenly breaks down. John, the production operator, immediately punches the red, flashing “Equipment Failure” button. As a result, all critical equipment in the production unit shuts down as a precautionary measure. The entire production process grinds to a halt.

John rushes to inform the production manager, Anne, about the equipment failure. Anne pages the maintenance supervisor, Raul.

12:15 p.m.
After meeting with Anne to discuss the situation, Raul collects all the information he can about the equipment failure from John. Back in his office, he begins to sort through relevant documentation on his desktop computer. He pulls up various files, wading through manuals and maintenance records to find patterns that would serve as a reference point for carrying out some basic troubleshooting. He also calls the equipment manufacturer to request that service technicians come as soon as possible. Finally, he passes along the troubleshooting information to John.

3:35 p.m.
John returns to the shop floor with an assortment of troubleshooting materials, which he then begins applying to the malfunctioning motor.

---

1 The names and events in SAP NetWeaver™ in the Real World are fictional. Any similarity to real people, companies, or events is merely coincidental.
About the SAP Business Intelligence

SAP Business Intelligence leads to informed decision-making by improving the ability of an enterprise to access and explore information, analyzing that information, and helping people develop understanding and insight based on that information.

Data in itself is not insightful; it must be converted into useful information by being grouped together in meaningful ways. Only then does one acquire the knowledge and ability to make decisions in the best interests of his business. BI provides the requisite decision support system for the user to make these informed decisions.

With BI, data can be analyzed from operative SAP applications, other business applications, and external data sources such as databases, online services, and the Internet. BI enables Analytical Processing, which processes information from large amounts of data. BI comes pre-configured with Business Content, providing users with ready-made scenarios and objects, thus simplifying implementation. This Business Content is based on the vast experience SAP has across various industries.

With the SAP Business Explorer Analyzer (BEx Analyzer), BI provides flexible reporting and analysis tools for analysis and decision-making support in an enterprise. Users can create Microsoft Excel reports or Web-based reports (BEx Web). BEx Analyzer gives a broad range of users access to information in the SAP® Business Warehouse, through the SAP® Enterprise Portal, over the Intranet (with BEx Web), or through mobile devices (with WAP-enabled mobile telephones and Personal Digital Assistants).

Implementation Basics

Every BI implementation begins with a set of business requirements. While the reporting phase is technically last in the implementation chain, all major business requirements map to this phase. Therefore, all phases of the BI implementation are modeled accordingly. The implementation scenario at Iridium Motors takes the same approach in this article.

Before we embark on this endeavor, we will first examine some basic guidelines. A step-by-step approach is then taken on how to build a scenario in the backend in order to begin building specific Web-based reports. Sample data is provided, though proprietary data may be substituted.

The output of this process is an InfoCube. The Business Explorer (BEx) tools are used to build reports based on the InfoCube that will map to the business requirements.
Prerequisites

Installed Software
It is assumed that the reader has a working installation of SAPGUI and the BW Frontend Add-On appropriate for the software release of the BW server where you choose to build. A matrix of information on FEP dependencies based on backend (server) patch levels can be found at SAP Service Marketplace:

- Go to http://service.sap.com/bw
- Select the BW version from the left navigation
- Select Frontend -> Frontend Compatibilities

In general, the BW Add-on is backwards-compatible; a simpler approach is to simply update your SAPGUI and BW Add-on via SAPPCADM and use that.

Knowledge
Basic knowledge of ABAP and SAP BI are an advantage.

Scenario
We have seen Web Dynpro and Exchange Infrastructure making their contribution to this scenario. We’ll see now how BI helps and takes the scenario forward.

Navigation Tips and Naming Conventions
- The bulk of this script focuses on the Administrator’s Workbench in SAP BW. This can be accessed via transaction RSA1.
- InfoObject maintenance can be accessed via transaction RSD1.
- Substitute your initials (or numeric digits) wherever “XX” is referenced throughout this implementation. Be sure that the initials or digits used are the same throughout the dataflow.
Terminology/Concepts

Terminology

Master Data
Master data is descriptive data generally used to make reports less technical in appearance. Master data includes: text descriptions for a technical key (e.g., “boiler” for equipment ID 1234), data attributes for the technical key (e.g., equipment color, size, and location), and possibly hierarchical information for the widget. Master data describes the what, where, when, and who of a transaction.

Transactional Data
This is the factual data of a specific business transaction. It generally carries technical information about a specific sale or transaction at a very granular (possibly line item) level. In addition to having the technical keys to describe who, when, where, and what, it also contains numeric values of how many or how much was sold/transferred/lost or otherwise accounted for.

Transaction data might take the form of:

```
EQUIPMENT, DATE, COST: 1234, 20040707, USD34.00
```

Note that transactional data is delimited by commas. This will be an important fact, as most of the data here is presented to BW in the “CSV” (Comma Separated Value) file format (commonly known as “flat files”).

InfoObjects
InfoObjects are the basic information providers of BW. InfoObjects enable information to be modeled in a structured form in SAP BI. They can represent characteristics, key figures, units, and time. We load descriptive master data into InfoObjects.

InfoCubes
InfoCubes are the central data store for reports and evaluations. After loading master data into BI InfoObjects, transactional data is loaded into InfoCubes, the transactional data “storage containers.” Effectively, InfoCubes consist of facts, or transaction data, and then the technical keys that link to the relevant master data texts and attributes useful in reporting and analysis. From a technical perspective, there is much to be said about what an InfoCube is, but that is beyond the scope of this article. For our scenario, it is sufficient to focus on creating an InfoCube to facilitate the generation of queries and reports.

Administrator Workbench (AWB)
Administrator Workbench is the tool for controlling, monitoring, and maintaining all of the processes connected with data staging and processing in the Business Information Warehouse.

Business Explorer (BEx)
The Business Explorer is the BI component that provides flexible reporting and analysis tools for strategic analyses and decision-making support within a company. These tools include: BEx Query Designer, BEx Web Application and BEx Analyzer, and BEx Information Broadcaster. With BEx Mobile Intelligence, you can call up BEx Web queries and
applications remotely using a PDA or WAP-enabled mobile phone, or download them for offline usage.

**Concepts/Reasoning**

As explained earlier, business requirements are looked at first. At Iridium Motors, Raul would like to execute a report to obtain information regarding the equipment failure. What information will his report provide in the report? There are myriad parameters; in this scenario Raul will include: Equipment ID, time of failure, reason for failure, possible solutions to the problem, time necessary to correct the problem, reported by (person), repaired by (person), responsible person, and cost of maintenance.

There are two types of master data, text and attributes. These also represent two different kinds of master data loads:

- **TEXT DESCRIPTIONS** of the technical keys;
- **ATTRIBUTES** of the product are also listed: Product Class, Product Group, Product Line, and Business Unit are all related back to specific SKUs (individual, unique Product IDs).

Transactional data is loaded once the InfoCube is ready. Transactional data sources involve a few more steps than master data loads. It might be expected that transactional data is modified or “transformed” as it passes into and through the SAP BW system. As a result, there are several intermediate stages as the data travels into an InfoCube.

The InfoSource is the first stage. It is a collective name for the set up of the source system to be used (flat files are considered source systems in BW) and the fields to be bundled together (called the “transfer structure”) from the source system (flat file); it then provides the possibility in several places for transformation of the data. The first of these possible intervention points is with “transfer rules.” Our data is already in the proper format, so no transformation will actually take place; fields in the flat file will map directly to InfoObjects in BW—but it is not always so simple. Update Rules are defined for loading data into the data target (InfoCube).
In the end, our goal is to produce an overall data flow similar to this diagram:

**Master Data**

For master data, an Employee InfoObject (without text) will be created with “Name,” “Address,” and “Telephone” as attributes. Text will not be maintained separately since name is made an attribute. The master data will contain a list of all employees presently at the plant. An Equipment InfoObject (with text) will be created with “Manufacturer,” “Location,” and “Supplier” as attributes. Equipment description will be loaded as text to show both types of data uploads. The master data will contain a list of all equipment present in plant.

**Transaction Data**

After InfoObjects “Reason for failure” and “Solution to problem” will be created. For “Time of failure” and “Time to correct the problem” 0CAL_DAY and 0TIME will be used, already supplied by SAP. “Responsible person,” “Reported by (person),” and “Repaired by (person)” are created by taking “Employee” as the reference InfoObject, as each of these three individuals are employees. “Cost of maintenance” will be created as key figure.

**Dimensions**

While creating the InfoCube, four dimensions (perspectives) are created and assigned suitable characteristics, keeping in mind the generic modeling and reporting requirements:

- Employee: Responsible person
- Equipment: Equipment
• Failure repair details: Repaired by, Reason for failure, Solution to problem, Maintenance time
• Failure reporting details: Time of failure, Reported by

Reporting can be carried out on each of these dimensions individually or in combination. Apart from the requirement of obtaining failure information, the user can create reports of employee or equipment information. Thus, this modeling provides flexibility.
Step-by-Step Solution

Step 1: Creation of InfoObjects for Master Data

As decided earlier, Employee and Equipment characteristics will be created. Before creating InfoObjects, InfoCatalogs are first created for both characteristics and key figures. Characteristic InfoObjects are then created in characteristic InfoCatalogs, and key figure InfoObjects in key figure InfoCatalogs for easy maintenance. InfoObjects can also be created in transaction the RSD1 screen.

While creating info object do not change the defaulted values on any screen if not told in instructions.

1. Logon to the BW system with your user name and password.
2. Execute transaction RSA1 to start the SAP BW Administrator Workbench.
3. Create an InfoArea by right-clicking InfoProvider and selecting Create InfoArea. Provide a technical name (ZIADEMO_AB) and description.
4. Select *InfoObjects* from the left hand column to switch to the InfoObject view. Locate the InfoArea ZIADEMO_XX, right-click on it and select *Create InfoObject Catalog*.

5. Select the *Key Figure* radio button and enter the technical name of the InfoCatalog for key figures (ZICKDEMO_XX) and a description.
6. Select the Create button to create InfoCatalog.

7. Activate the InfoCatalog and return to the InfoObject view.

8. Follow the same procedure (selecting the Char. radio button) to create the InfoCatalog for characteristics: ZICDEMO_XX.

9. In the InfoObject view, right-click on InfoObject catalog for characteristics: ZICDEMO_XX and select Create InfoObject.

10. Enter “Employee” in the Long Description field and ZEMPL_AB as the technical name.

11. Click Enter.
12. On the General tab, enter the following data in the screen shot below.

13. Select the Master data/texts tab.

14. Make sure that the With texts checkbox is not checked.

15. Select the Attributes tab.
16. Enter the employee attributes.

17. As these attributes are also InfoObjects (without master data), they need to be created one by one. Double click on ZNAME_XX. The following screen will appear.
18. Click Enter. You will see the InfoObject maintenance screen.

19. On the General tab, enter the following data:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datatype</td>
<td>CHAR – Character string</td>
</tr>
<tr>
<td>Length</td>
<td>15</td>
</tr>
</tbody>
</table>

20. On the Master data/texts tab, enter the following data:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>With master data</td>
<td>Uncheck</td>
</tr>
</tbody>
</table>

21. Click Enter.

22. Again the screen will appear for ZADD_XX, just as it did for ZNAME_XX. Enter Address as the description. Follow the same procedure as above.

23. Click Enter and the screen for ZTEL_XX will appear. Enter Telephone Number as the description. Follow the same procedure as above, with the exception of the following data under the General tab:
24. Click Enter. You will see the following screen.

![](image)

25. Click Save.

26. Activate the Employee InfoObject by clicking the Activate icon, then select the Activate dependent InfoObject radio button.

27. The same procedure is used to create and activate the Equipment InfoObject and its attributes.

28. On the General tab, enter the following data:

For Equipment: ZEQUIP_ XX:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datatype</td>
<td>NUMC</td>
</tr>
<tr>
<td>Length</td>
<td>10</td>
</tr>
<tr>
<td>Description</td>
<td>Equipment</td>
</tr>
</tbody>
</table>
For Manufacturer/Supplier: ZMANUF_XX /ZSUPPL_XX:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datatype</td>
<td>CHAR</td>
</tr>
<tr>
<td>Length</td>
<td>15</td>
</tr>
<tr>
<td>Description</td>
<td>Manufacturer/Supplier</td>
</tr>
</tbody>
</table>

For Location: ZLOC_XX

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datatype</td>
<td>CHAR</td>
</tr>
<tr>
<td>Length</td>
<td>8</td>
</tr>
<tr>
<td>Description</td>
<td>Location</td>
</tr>
</tbody>
</table>

29. On the *Master data/texts* tab, enter the following data:

For Equipment:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>With master data</td>
<td>Check</td>
</tr>
<tr>
<td>With text</td>
<td>Check</td>
</tr>
</tbody>
</table>

For Manufacturer, Location, and Supplier:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>With master data</td>
<td>Uncheck</td>
</tr>
<tr>
<td>With text</td>
<td>Check</td>
</tr>
</tbody>
</table>
Step 2: Loading Master Data

Loading InfoObject Text

Text exists for Equipment only. Text will be loaded from the flat file.

1. Execute transaction **RSA1** to start the SAP BW Administrator Workbench.

2. Select InfoSources from the left-hand column to switch to the InfoSource view.

3. Right-click on **InfoSource** and select create application component **ZACDEMO_ XX**.

4. Right-click on **ZACDEMO_ XX** and select **Create InfoSource**.

5. Select **Direct Update of Master Data** and enter your Equipment InfoObject Name: **ZEQUIP_XX**. Click OK through the subsequent screens.

6. Right-click on the new InfoSource for your InfoObject and select **ASSIGN DATASOURCE**.

7. Enter “**PC_FILE**” in the dialog box.

8. Click OK/YES through subsequent dialog boxes.

9. Make sure the **Transfer Rules** tab is selected on the next screen.

10. If nothing is selected, click the icon for **Propose Transfer Rule** in the middle of the screen.

11. Click **Activate**.

12. Use the pulldown menu for DATASOURCE and select the **Texts** data source.

13. Click **Activate**.
14. Select the green arrow to return to the Administrator Workbench: Modeling.

15. Right-click on the DataSource icon, which is now attached to your InfoObject. Select *Create InfoPackage*.

16. Select *Text* as the upload type and enter a description for the InfoPackage (“Info Pack for Equipment Text XX”).

17. Click *Save*. 
18. Create an Excel spreadsheet as seen in the following screen shot. Save it as “Zequip_Texts_Upload.csv” to your local hard drive.

![Excel spreadsheet screenshot]

**IMPORTANT**: Be sure to save the file as “CSV.”

19. Select the *External Data* tab on the *Scheduler* (Maintain InfoPackage) screen.
20. Select the file that you saved in the *Name of File* field and enter the other values as shown below.

21. Click on *Preview* to confirm that the data format is correct.

22. Select the *Processing* tab and make sure that *PSA and then in the InfoObject (Package by Package)* is selected.
23. Select the **Update** tab and make sure **Full update** is selected.

24. Make sure the CSV file is closed.

25. Select the **Schedule** tab and click **Start** (with **Start data load immediately** selected).

26. Click on the **Monitor** button. You can review the load progress here.

---

**Loading InfoObject Attributes**

The attributes for the Equipment and Employee InfoObjects are loaded from the flat file.

1. Return to the SAP BW Administrator Workbench by clicking the **Back** button.

2. Locate the InfoSource you created for ZEQUIP_XX.

3. Expand the list of DataSources for this InfoObject.

4. Right-click on PC_FILE.

5. Select **Create InfoPackage**. As previously described, create another InfoPackage for attribute upload, now selecting Equipment (Master Data) instead of Equipment (Texts) as chosen in step 16 above.
6. Execute the remaining steps and upload the Zequip_Attribs_Upload.csv file, as pictured here:

![Excel Sheet](image)

7. Follow the same procedure for the Employee InfoObject. Right-click on application component ZACDEMO_XX in the InfoSource view, click Create InfoSource (direct update for ZEMPL_XX), Assign data source, then activate transfer rules.

8. Create an InfoPackage for PC_FILE and upload the file to load employee attributes.
Step 3: Create Additional InfoObjects for Transactional Data

1. Logon to SAP BW and execute transaction **RSA1**.

2. In the InfoObject view, locate the InfoArea (ZIADEMO_XX) and characteristic InfoCatalog (ZICDEMO_XX).

3. Follow the same procedure as described in Step 1 to create char type InfoObjects.

4. First create InfoObjects for “Reason for failure” and “Solution to problem.”

5. For Reason for failure/Solution to problem: ZREASN_XX/ ZSOLN_XX, enter the following data:

   On the **General** tab:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datatype</td>
<td>CHAR – Character string</td>
</tr>
<tr>
<td>Length</td>
<td>15</td>
</tr>
<tr>
<td>Description</td>
<td>Reason for failure/Solution to problem</td>
</tr>
</tbody>
</table>

   On **Master data/texts** tab, enter the following data:

   For Equipment:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>With master data</td>
<td>Uncheck</td>
</tr>
<tr>
<td>With text</td>
<td>Check</td>
</tr>
</tbody>
</table>

6. Right-click ZICDEMO_XX, select **Create InfoObject** to create a new InfoObject for each of the three InfoObjects: “Responsible person” (ZRESP_XX), “Reported by” (ZREPTD_XX), and “Repaired by” (ZREPD_XX).

7. Enter reference characteristic as ZEMPL_AB and their respective description. There is no need to do anything extra in subsequent screens; simply activate these InfoObjects individually.
8. Return to the application area and locate key figure InfoCatalog (ZICKDEMO_XX).

9. Right-click ZICKDEMO_XX and select Create InfoObject to create a new InfoObject for the “Maintenance cost” key figure.

10. Enter “ZCOST_AB” as the Technical Name and “Maintenance cost” as the description.

11. Click Enter. On the next screen, select Amount as for Type/data type and “USD” as the Fixed Currency.

12. Click Save/Activate.
Step 4: Building InfoSource for Transactional Data

1. Return to the SAP BW Administrator Workbench (transaction RSA1).

2. Select the INFOSOURCES area of the Data Modeling section of the Admin Workbench.

3. Locate the InfoArea ZACDEMO_XX.

4. Right-click and select Create InfoSource.

5. Select Flexible Update. Provide a technical name (ZFISDEMO_XX) and description (“Info Source for transactions AB”). Click Transfer (Enter).

6. Right-click on this new InfoSource and select Assign DataSource.

7. Type “PC_FILE” and click Transfer (Enter).

8. Click Yes on the next dialog.
9. On the next screen, on the InfoObjects column, add the following InfoObjects (using the technical name in parenthesis):
   
   - Responsible person (ZRESP_XX)
   - Equipment (ZEMPL_AB)
   - Reported by (ZREPTD_XX)
   - Date of failure (0DATE)
   - Reason for failure (ZREASN_XX)
   - Repaired by (ZREPD_XX)
   - Solution to problem (ZSOLN_XX)
   - Maintenance time (0TIME)
   - Maintenance cost (ZCOST_XX)

**Note:** The order of InfoObjects here is important. The same order must be reflected in the columns of your flat file.

10. Click on the *Transfer Rules* tab.

11. Select the *Propose Transfer Rules* button. Make sure all InfoObjects match up and you get a green light on the *Transfer Rules* tab.
12. Check your Communication Structure just to make sure all the InfoObjects exist in this list as well.

13. Activate your InfoSource. This is the activated view:

![Image of InfoSource activation](image)

14. Preview the data in the new InfoSource. Click on the **DataSource/Trans. Structure** tab and click Preview button.

15. Select your file and provide file details.
16. Click *Transfer* (Enter) to view results.

Note: A simulation can not yet be performed; there must be a data target (InfoCube) in place.
Step 5: Building the InfoCube

1. Switch to the InfoProvider view of the Data Modeling section.

2. Right-click on the InfoArea ZIADEMO_XX and select Create InfoCube.

3. Select Basic cube and provide a technical name (ZICART_XX) and description (“InfoCube for article demo XX”). Click the Create button.

4. On the Characteristics tab, select the InfoSource icon in the Template area.
5. Select your InfoSource (ZFISDEMO_XX). Select Yes to transfer the InfoObjects from your InfoSource.

6. On the Characteristics tab, click on the Dimensions button. Select No in the dialog box.
7. Click *Create* and provide four dimension names as follows:

8. Click on the *Assign* tab.

9. Map InfoObjects to the dimensions. Select the checkbox next to a characteristic name. Place the cursor in the box with the desired dimension name. Click *Assign*. Assign the characteristics as shown to dimensions.
10. Click Transfer (Enter).

11. Click on the Time Characteristics tab.

12. Click on the All InfoObjects button to list all time characteristics.

13. Select the following Time Characteristics and add them to the cube:
   a. 0CALDAY
   b. 0CALMONTH (displays as Calendar Month/Year)
   c. 0CALMONTH2 (displays the name of the Calendar Month only)
   d. 0CALYEAR
14. Click on **Key Figures** to verify this content.

15. Click **Save** and **Activate**.
Step 6: Create Update Rules for Transactional Data

This step will create update rules for the InfoCube.

1. Return to the InfoProviders list in the Data Modeling section of the SAP BW Admin Workbench.

2. Right-click on your InfoCube.

3. Select Create Update Rules. Click the radio button for InfoSource object and then select your InfoSource (ZFISDEMO_XX).

4. Click the check button.

5. Click Enter.

6. Click Save and Activate.

7. Go back.
Step 7: Load Transactional Data

1. In the SAP BW Administrator Workbench (transaction RSA1), change to the InfoSources view of the Data Modeling section.

2. Locate the InfoArea (ZACDEMO_XX).

3. Locate the InfoSource (ZFISDEMO_XX) in the InfoArea.

4. Expand the list of DataSources attached to your InfoSource.

5. Right-click on PC_FILE and select Create InfoPackage. Provide a description.

6. Click Save.
7. Create the following Excel file. Save it as “Transaction_Data.csv.” Note the file location and close it.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>responsible person</td>
<td>reported by date</td>
<td>reason of repair</td>
<td>solution</td>
<td>time taken</td>
<td>maintenance cost</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>9001</td>
<td>110001</td>
<td>9005</td>
<td>20040101 CONTROL</td>
<td>9008</td>
<td>CHANGE</td>
<td>223000</td>
<td>1000</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>9002</td>
<td>110002</td>
<td>9006</td>
<td>20040202 VALVE LEAK</td>
<td>9007</td>
<td>CHANGE</td>
<td>180000</td>
<td>900</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>9003</td>
<td>110003</td>
<td>9007</td>
<td>20040303 OIL LEAK</td>
<td>9008</td>
<td>FRESH OIL</td>
<td>160000</td>
<td>950</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>9004</td>
<td>110004</td>
<td>9008</td>
<td>20040404 NUT FAIL</td>
<td>9004</td>
<td>CHANGE</td>
<td>104500</td>
<td>500</td>
<td></td>
</tr>
</tbody>
</table>

8. Select the *External Data* tab and make the following settings. Use the CSV file you saved in the last step for the “Name of File” field.
9. Verify that your InfoCube is listed in the *Data Targets* tab.

10. Verify that this is a full update on the *Update* tab.

11. Click *Start* on the *Schedule* tab.

12. Click on the *Monitor* button to monitor the data load.
Step 8: Reporting & Analysis: Create a Query & Web Application

1. Return to the InfoProvider view of the Administrator Workbench.

2. Right-click on your InfoCube, select Manage.

3. You should see green lights on the request line as pictured below. There should also be an icon in the Ready for Reporting column of the request line.

Assuming a successful data load, check your work with BEx tools:

4. Open the SAP Web Application Designer
   From the Windows START menu -> Programs -> Business Explorer -> Web Application Designer.

5. Logon to the BW system.
6. The SAP Web Application Designer should open with a new, blank template in the main area of the screen.

7. From the Tools menu, Select Query Designer.

8. Click on the new query icon.

9. If your cube is not displayed, type in the technical name of your cube in the InfoProvider line (ZICART_XX) and click OK.
10. Drag rows and columns in as shown here.
11. Right click on “Reason for failure” and select *Properties.*
12. In the Suppress Results Rows dropdown select Always.

13. Do the same for all other characteristics present in the Rows box except for the Equipment characteristic.

14. Right-click on “Repaired by” and select Attributes -> Name. The name and employee id will be displayed.

15. Right-click on “Date” and select Properties. Enter “Date of failure” in description.
16. Do the same for “Time” and enter “Maintenance time” in the description.

17. Do the same for the “Reported by” characteristic.

18. Save the query with Technical name (ZDEMOQRY_XX) and description (Demo Query AB™).

19. Test the query by clicking on the Launch Query in Web Browser icon.

20. Click the green check (✔️) to drop back to the Web Application Designer.
21. From the Insert menu, select Table -> Insert Table. Insert a table with 2 rows and 1 column.

![Insert Table dialog box]

22. Select a Dropdown Box out of the Standard Items list and drag it into the top cell of the table in the Web Application Designer template.

![Standard Items list]

`Standard Items`
23. Drag and drop the Table item into the bottom cell of the table in the template.
24. On the General tab of the Properties for the Table item, select the DataProvider.

Select the query you just created above. Once selected, this will default as the data provider for all other items in the template.
25. Select the dropdown and connect it to the Equipment characteristic (you select the characteristic in the Web Item tab of the properties of the dropdown box).

26. Save the template with the technical name (ZEQUIP_FAILURE_XX) and description (“Equipment failure Web application XX”).
27. Launch it in a Web browser for testing.

28. One can view details of particular equipment by selecting it in the dropdown box.

29. Additional Web applications may be created in a similar manner.
Preview of “SAP NetWeaver in the Real World” Part V

In the final installment of the SAP NetWeaver in the Real World series, the development team at Iridium Motors integrates the Web Dynpro application created earlier as an iView into the SAP® Enterprise Portal (EP).

SAP EP enables the production manager, Anne, to monitor the status of the equipment on the shop floor at all times and to communicate with Maintenance Supervisor Raul using instant messaging provided by SAP® KM Collaboration technology. Through a portal interface, Raul is able to search through the equipment documentation. He is also able to analyze the service history of the equipment by viewing the relevant BW reports that are integrated as iViews into the portal environment.

Perhaps most importantly, Iridium Motors is able to partially resume production by lunchtime.
References

1. help.sap.com

2. BI_Admin_II___Final.doc at SAPNET\IDES by Ms. Larissa Gonsior-Wehrmann

Disclaimer:
The article aims at providing an introduction to using SAP NetWeaver and it cannot be used as is for running a business scenario in a production environment. The article also does not discuss the security issues, optimization, performance, and exception handling. The article contains definitions that have been taken from help.sap.com. Refer to help.sap.com for more information.